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Nota: Itemii au o singura varianta corecta. Timp de lucru 90 minute. Se acorda doua puncte
pentru fiecare item rezolvat corect.

TEST GRILA

1. Pentru a seta o traiectorie particularizatd atunci cand vrem sa animam un obiect folosim:

a) Expunere b) Intrumente (Tools)> c¢) Expunere Diapozitive d) Expunere
Diapozitive (Slide Particularizare (Customize)>  (Slide show) > Animatie Diapozitive (Slide
Show) > Setari Adaugare Efect (Add effect)> particularizatd (Custom show) > Expuneri
Actiune (Action Cai de miscare (Motion animation) > Adaugare particularizate (Custom
Settings) > Adaugare  path)> Desenare Cale Efect (Add effect)>Caide  show) > Adaugare
Efect (Add Particularizata (Draw custom migcare (motion paths) Efect (Add effect)>Cai
effect)>Desenare Cale path) >Desenare Cale de miscare (motion
Particularizata (Draw Particlarizata (Draw paths)>Desenare Cale
motion path) custom path) Particularizata (Draw

custom path)

2. Pentru a crea o comanda automata pentru efecturea unor functii simple intr-o prezentare folosim:

a) Instrumente b) Instrumente (Tools)> c) Fisier (File)> Proprietati d) Instrumente (Tools)
(Tools)> Inregistrarea  Atelier partajat (Shared (Properties) >Particularizare
unei macrocomenzi workspace) (Customize)

(Record macro)

3. Pentru a crea un cuprins automat intr-o prezentare PowerPoint folosim:

a) optiunea Slide b) optiunea Rehearse c¢) optiunea Common Task  d) optiunea Summary
Show (Expunere Timings (Programarea (Taskuri comune) Slide (Diapozitiv
diapozitive) repetitiilor) rezumat)

4. Inserarea unor butoane intr-un diapozitiv se face din meniul:
a) Insert (Inserare) b) Edit (Editare) c¢) Format (Formatare) d) Slide Show
(Expunere diapozitive)

5. Pentru a realiza un buton intr-un diapozitiv, buton ce va ajuta la incheierea expunerii folosim:

a) Expunere b) Expunere diapozitive c¢) Expunere diapozitive d) Expunere diapozitive
diapozitive (Slide (Slide Show) >Butoane (Slide show)> Animatie (Slide Show) > Butoane
Show) >Setari actiune actiune (Action particularizata (Custom de actiune (Action
(Action Settings) > Buttons)>Hyperlink animation) > Hyperlink Buttons)> Executare
Executare catre>"Incheierea expunerii"  catre> "Incheierea macrocomanda (Run
macrocomanda (Run  (End show) expunerii". macro)>Comanda
macro)> Comanda creatd anterior

creatd anterior

6. Alegerea unui tip predefinit de diapozitiv se face din meniul Format, alegand:
a) Slide Layout b) Animation Scheme (Efecte c¢) Background (Fundal) d) Font
(Aspect diapozitiv) de animatie)
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7. Pentru a uni doua prezentari Power Point intr-o singura prezentare folosim:

a) Inserare (Insert)> b) Editare (Edit)> Lipire c) Fisier (File)>Proprietati  d) Intrumente (Tools)>

Diapozitive din fisiere speciald (Paste special) (Properties) Comparare si imbinare

(Slides from files) prezentari (Compare
and merge
presentations)

8. Care dintre urmatoarele enunturi referitoare la utilizarea instrumentului Pen Color este adevarata?

a) se poate alege in b) se poate alege in c) stabileste intervalul de d) se poate alege in

faza de proiectare a momentul derularii timp dintre doua afisiri de  modul de vizualizare

prezentarii prezentarii (modul Slide diapozitive Slide sorter (Sortare
View) diapozitive)

9. Animatia particularizata poate sa includa:

a) Entrance, Exit b) Emphasis effects, Motion ¢) variantele a si b d) niciuna dintre
effects (efecte de paths (efecte accent, cdi de variante
intrare, iegire) migcare)

10. Care afirmatie nu este adevarata, in legaturd cu modul de vizualizare a prezentdrii Slide Sorter View
(Sortare diapozitive):

a) se poate edita textul b) se poate elimina un slide ¢) se pot reordona d) se poate insera un
din slide slide-urile slide nou

11. Parametrul COLLSPAN permite:

a) extinderea unei b) extinderea unei celule pe mai  c¢) definirea spatiului d) definirea spatiului
celule pe mai multe multe linii dintre celule lasat dintre continutul
coloane celulei si chenar

12. Ce rezultat obtineti daca inserati tag-ul <i><b>Concursul</b></i><u>CIA</u> SUCEAVA<b>2009</b>

a) Concursul CIA b) Concursul CIA SUCEAVA b) Concursul CIA b) Concursul CIA

SUCEAVA 2009 2009 SUCEAVA 2009 SUCEAVA 2009

13. Care este tag-ul corect pentru a insera un hypertext ?

a) <link> Acesta este  b) <link> Acesta este un link c) <a src d) <a href

un link </link> ="imagine.gif”> Acesta ="figier.htm”> Acesta
este un link este un link </a>

14. Daca pe magistrala de date se transmite cate un bit pe fiecare linie de date atunci transmiterea este:
a) in paralel b) in serie c) in retea d) nici una dintre
variante

15. Daca o retea de calculatoare respecta topologia de tip stea, reteaua de calculatoare devine inutilizabila
daca:
a) conexiunea dintre  b) dispozitivul central nu  ¢) aceasta topologie de retea d) cablul de legatura

doua calculatoare functioneaza permite functionarea dintre doua calculatoare
alaturate nu permanenta a retelei indiferent  este intrerupt
functioneaza de evenimentele care pot apare
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16. Care dintre urmatoarele butoane NU se gasesc intr-o casetd de dialog ?

a) buton radio b) buton de inchidere ¢) buton de tip caseta de d) buton de restaurare
(Close) validare (Check Box) (Restore)

17. Pentru a afiga sinonimele respectiv antonimele unui cuvant selectam:

a) Tools (Instrumente) b) Tools (Instrumente) c) Format d) Tools

—>Language —>Language (Format)—>Change (Instrumente)—>

(Limba)—>Set (Limba)->Thesaurus (Lexicon)  Case (Modificare dupa  Spelling and grammar

Language (Stabilire caz) (Corectare ortografica

limba) si gramaticald)

18. Care dintre variantele de mai jos, referitoare la functia Track Changes (Urmarire modificare) este
adevarata?

a) este utila atunci b) un utilizator poate accepta sau c¢) poate fi utilizata d) toate variantele sunt
cand mai multe refuza modificarile facute de un  atunci cand se combind adevérate

persoane lucreaza la alt utilizator pe documentul creat doud documente

editarea unui de el

document

19. Un tabel Word contine intr-o celuld un camp calculat cu ajutorul optiunii Formula (Formula). Daca se
modifica datele referite de formula atunci valoarea calculata:

a) nu se actualizeazd  b) se actualizeaza automat ¢) se actualizeaza d) se actualizeaza

automat selectand valoarea din  selectdnd celula care
celula care contine contine formula si
formula si apasand apasand tasta F10
tasta F9

20. Cate functii imbricate se pot regasi intr-o formula Excel ?
a)7 b) 9 c) 12 d) 10

21. In domeniul B4:B11 avem un set de valori numerice. Aceste valori trebuie inmultite toate cu valoarea 5,
iar rezultatele Tnmultirilor trebuie plasate in domeniul C4:C11. Valoarea 5 se gaseste in celula Al. Care este
formula corecta pe care trebuie sa o scriem in celula C4 pentru ca prin copiere pe coloand, sa rezulte valorile
corecte?

a) =B4*Al b) =$B4*A1 c) =B4*$A1 d) =B4*$AS1

22. Pentru a realiza o situatie a elevilor unei clase se trec intr-o foaie de calcul urmatoarele date: nume(A),
med romana(B), med_fizica(C), med generala(D), situatie(E). Un elev este considerat promovat daca toate
mediile sunt mai mari sau egale cu 5, altfel el este corigent. Ce formula se va aplica in celula E2?

a) b) c) d)
=[F(AND(B2<5;C2<5;D =IF(OR(B2<5;C2<5;D2<5; =IF(OR(B2<5;C2<5;D =IF(OR(B2>4;C2>4;D2>
2<5;E2<5); corigent”; E2<5);”corigent”; 2<5;E2<5);”promovat”  4;E2>4); corigent”;
’promovat”) ”promovat”) ;’corigent”) ’promovat”)

23. Daca dorim sa inghetam atributele coloanelor din randul 3 si atributele randurilor din coloana A, pe ce
celuld trebuie sa facem clic inainte de a executa comanda inghetare panouri?
a) B4 b) Al c)B3 d) B2
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24. Care din urmétoarele functii Excel concateneza textele specificate ca argumente?

a) b) c) d)

CONCAT(textl ;text2) CODE(text1;text2) CONCATENATE((textl;text2) EXACT(textl;text2)
25. Stilul Comma(0) (virgula(0)):

a) adaugda doua b) rotunjeste zecimalele si  c¢) Inmulteste numarul cu d) adauga trei
zecimale §i introduce introduce virgula in calitate 100 si adauga simbolul de ~ zecimale si introduce
virgula 1n calitate de de separator de mii procent virgula 1n calitate de
separator de mii separator de mii

26. Mesajul de eroare #VALUE! apare cand:

a) formula se referd lao  b) formula se refera la o ¢) in formula s-a utilizat o d) valoarea nu este de
celuld inexistenta celuld in care nu existd incd  denumire pe care Excel nu  tipul corespunzator
nici o valoare 0 recunoaste argumentului

27. Care din urmatoarele functii au ca argument o plaja discontinua de celule?
2) b) ©) d)
=SUM(A2:A7) =MAX(59;36;84) =SUM(A2:A7;A9;A11:A20) =IF(A1=A2;"Bun";Rau")

28. Ce returneaza functia =ROMAN(1976) ?
a) MMIX b) MCMLXXXVI ¢) MMCMLXXVI d) MCMLXXVI

29. Care este efectul produs de scrierea intr-o celuld a unei foi de lucru a urmatoarei formule de calcul ?
=(ROUND(1575,368;2)+POWER(3;5))* PRODUCT(4;5;0)

a) 1818,37 b) 0 c) 1575,368 d) 1818,368

30. Apelarea functiei MEDIAN in formatul urmator =MEDIAN(A1:F1) pentru valorile din figura de mai jos,
A, B C D E F

va avea ca rezultat afisarea valorii: 1 1 2 3 4 ] b

a) 3 b) 4 c)2 d) 3,5

31. Apelarea functieit HARMEAN in formatul urmator =HARMEAN(A1:G1) pentru valorile din figura de
mai jos, va avea ca rezultat afisarea valorii:

AB|IC|DIEIF|G

1 M 14112 (22 |2
a) 1,57 b) 1,4 ) 1,5 d)2

32. Ce afiseazi =POWER(2,FACT(INT(SIGN(RAND()))))?
a) 1 b) 2 )4 d) 8

33. Care este valoarea obtinuta prin aplicarea functieic =COUNTA(BI1:12) ?
BI|C|D|E|F[GIH[I]
7 g 89 658 7B

[
~
—_

b) 5 o) 16 d) 8
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34. Formula: =IF(LEN(A1:A5)>=3,"adevarat","fals") va avea ca efect:

a) verificarea numerelor  b) inlocuirea notelor cu ¢) inlocuirea cuvintelor din  d) afisarea mesajului

din domeniul A1:A5 si mesajele ,,adevarat”/ ,fals” domeniul A1:AS5 cu ,,adevarat”/, fals” daca

inlocuirea celor >=3 cu mesajul ,,fals” lungimea cuvintelor

mesajul ,,adevarat” din domeniul A1:A5
este >=3

35. Formula =MID("Concursul National de Informatica Aplicata",1,FIND(" ","Concursul National de
Informatica Aplicata ")) are ca efect:

a) afisarea textului b) afisarea textului c) afisarea textului d) afisarea textului
,,Concursul National de  ,,Concursul” ,,Informatica” »Informatica Aplicata”
Informatica Aplicata”

36. Formula: =IF(RIGHT(A2,1)="a",CONCATENATE(A2,"escu"))

a) inlocuieste sirul de b) adauga in fata siruluide  c¢) modifica sirul de d) modifica sirul de

caractere din celula A2  caractere din celula A2 sirul caractere din celula A2, caractere din celula

cu sirul ,,escu” ,,escu” daca acesta are sufixul ,,a” A2, daca acesta are
adaugand sufixul ,,escu” sufixul ,,a” adaugand

prefixul ,,escu”

37. Ce va afisa functia =T(A1) daca in celula A1 introducem numarul 2009 ?
a) 2009 b) #VALUE! ¢) nu va afisa nimic d) 2010

38. Apelarea functiei ADRESS in formatul urmator =ADDRESS(10;2;1;FALSE;"EleviNote") va avea ca
rezultat:
a) EleviNote!$B$10 b) EleviNote!R10C2 c¢) EleviNote!C$2 d) EleviNote!R10C3

39. Apelarea functiilor MIN si CHOOSE in formatul urmator
=MIN(CHOOSE(3;A1:A6;B1:B6;C1:C6;D1:D6)) pentru valorile din figura aldturata, va avea ca rezultat
afisarea valorii:

AlB|C | D

1 g 9 4] 1

2 11 3] 2] 5

3 gl 7| 9 7

i 9 &8 5] 9

5 | 3| 5] 10

b 20 1| B| 12
a)0 b) 1 c)2 d)3
40. In Access functia TRIM(sir):
a) elimina spatiile b) elimina spatiile situate Tn  ¢) elimina spatiile situate d) elimina spatiile
situate 1n afara si in afara sirului in interiorul sirului situate 1n stanga sirului

interiorul sirului

41. Alegeti varianta care contine numai functii uzuale pentru date numerice:
a) ISNUMERIC(), b) RND(), ABS(), & c) ABS(), NOW(), INT() d) ISNUMERIC(),
RND(), ABS() RND(), STR()
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42. Intr-o baza de date ce contine tabelele Clase si Elevi pentru a obtine informatii numai despre clasele care
au introduse date despre elevii lor proiectdm o asociere de forma:
a) Left join b) Right join ¢) Inner join d) toate variantele

43. Allow Zero Length (permite lungime zero) se aplica datelor:

a) Currency si b) Memo si Currency ¢) Text si Memo (Text si d) Number si Memo
Autonumber (Moneda si  (Memo si Moneda) Memo) (Numar si Memo)
Autonumerotare)

44. Modificarile efectuate in regimul Datasheet View (Foaie de date):

a) nu afecteaza b) afecteaza ordinea si c) stabileste d) anuleaza

ordinea si caracteristicile campurilor  caracteristicile cAmpurilor caracteristicile
caracteristicile stabilite Tn regimul Design  stabilite in regimul campurilor stabilite in
campurilor stabilite View (Proiectare) Design View (Proiectare) regimul Design View
in regimul Design (Proiectare)

View (Proiectare)

45. Indexarea tabelelor ofera avantajele:

a) posibilitatea folosirii  b) selectarea dupa criterii c) actualizarea promptda a  d) toate variantele
expresiilor drept criteriu  unice indecsilor odata cu datele
de ordonare propriu-zise

46. In proiectarea unei relatii este adevarata propozitia:

a) relatia este n-n b) ambii indecsi trebuie sa  c) tabela nu poate fi legatd  d) legaturile dintre
aiba acelasi tip si aceeasi de mai multe tabele prin tabele nu se pot edita
expresie de indexare chei distincte

47. Daca intr-o interogare dorim sa obtinem elevii cu media necompletatd vom pune pe coloana media:
a) ISNOT NULL b) media=0 ¢) ISNULL d) media!=0

48. Daca dorim ca filtru aplicat asupra datelor sa fie variabil vom introduce numele variabilei intre:
a) paranteze rotunde b) acolade c) ghilimele d) paranteze drepte

49. Care din urmatoarele variante nu este un model conceptual al bazelor de date:
a) modelul ierarhic b) modelul tabel c¢) modelul retea d) modelul relational

50. Utilitarul care realizeaza grafice este apelat din:
a. Database (Baza de b. Database (Baza de date)> c. Database (Baza de date)> d. Database (Baza de
date)> Report (Raport)> Query (Interogare)> New > Report (Raport)> Chart date)> Query

New (Nou)> Chart (Nou)> Chart Wizard Wizard (Expert diagrama)  (Interogare)> Chart

Wizard (Expert (Expert diagrama) > New (Nou) Wizard (Expert

diagrama) diagramd) >New
(Nou)



